
XPRESS BILL PAY TUTORIAL

     Create a New Account

1. Go to  https://www.xpressbillpay.com/
2. Click the Create a New Account link
3. You will be prompted to enter your email address and to create and confirm a password.
4. Choose account type “personal,” fill out all the required fields and agree to the terms and conditions
5. Xpress Bill Pay will then send a verification email to the email address used for registration.  Verify your email 

address by clicking the “Verify Email” button from the email sent to you by Xpress Bill Pay.  Xpress Bill Pay will 
then confirm verification of your email, a new window will pop up in your web browser, and you will hit the 
“continue” button.

6. From there, Xpress Bill Pay will take you to the Add New Account page.

Add Your STR Account

1. Click the “Add Account” tab at the top of the page
2. Choose the City of Manzanita, Or as your billing location
3. If there are no billing organizations listed you can perform a search by entering the biller’s name, city, state or 

zip code in the search box
4. You will then be asked to select the bill type, you will select the “Transient Lodging Tax” option 
5. Fill out your MCA account number and the city supplied pin number included in this letter.
6. Hit the “Locate Account” button
7. Xpress Bill Pay will let you know that you were successful in locating your account
8. Hit the close button and you will be directed to your account 
9. You can always access your account on Xpress Bill Pay by clicking on the “Accounts” tab at the top of the Xpress 

Bill Pay web page

Locating and Filing of Quarterly Taxes

1. After closing the page, you will be directed to the Tax Returns page in Xpress Bill Pay.  Your Account name, 
account number, and the City of Manzanita will be listed.

2. You will be able to see all accounts created under that account number on the right-hand side of the screen.
3. Click the green “View” button to go to the Unfiled/Filed/Pending Returns page
4. Select the year in which the tax filing will take place
5. In the Unfiled Taxes line, select the quarter in which you will be filing the tax form
6. Fill out the tax form.  Only lines 1, 2a – 2e, and 11 are fillable.
7. Once filled out, you have the choice to save without filing or to file the return
8. If there are taxes due after the return has been filed, you can pay by clicking the green “Pay Now” button.  You 

can also pay by clicking the shopping cart at the top of the page.

You can create a pdf of the tax filing along with your account information, and any balance due by clicking on 
the pdf symbol at the top right side of the webpage

Payment options include ACH/EFT eCheck which will incur no service fees or credit card (Visa, MasterCard, 
Discover).  A 3% service fee will be charged on all credit card payments.

Payment

1. Select Pay Method -> Add a New Payment Method
2. Choose Payment Type and fill out all the required fields
3. Review and confirm payment amount.

https://www.xpressbillpay.com/


 

 

CITY OF MANZANITA 

 

Quarterly Transient Tax Report Instructions 

(Please note that this form will self-calculate, so only enter the required figures on the Lines directed.) 

 

Please be very careful to fill out your quarterly tax forms correctly and remit the correct amount of 

taxes and any penalties owed by their due date.  You will be assessed and invoiced for staff time 

related to determining the correct amount of taxes owed to the City.    

 

 

LINE 1.  GROSS RENT: Enter the total amount of all consideration charged to the transient for 

occupancy - including all fees - assessed by the Owner, their agent or a Transient Lodging Intermediary, 

whether or not received by the Owner, that is not optional or refundable, excluding taxes.  Rent is reported 

each quarter on stays that were completed in that quarter. 

 

Manzanita Ordinance 16-03 Section 2 (g) defines Rent as: The full consideration charged, whether or not 

received by the Transient Lodging Tax Collector, for the Occupancy of Transient Lodging valued in money 

or in goods, labor, credits, property, or other consideration valued in money, without any deduction. 

Except as otherwise provided in this section, Rent includes all fees, charges and assessments (including but 

not limited to processing fees, cleaning fees or fees for maid service and pet fees) charged, assessed or 

allocated by the Operator or Transient Lodging Intermediary for the Occupancy of the Transient Lodging, 

the payment of which is not optional and not refundable. 

 

Manzanita Ordinance 16-03 Section 7 A requires that:  The Tax shall not be paid to the City by the 

Transient Lodging Tax Collector until after the Transient has completed the stay. All Tax accrued or paid 

during an Occupancy that spans multiple calendar quarters shall be treated, for tax remittance purposes, 

as if collected on the last day of that Occupancy. 

 

2.  LESS ALLOWABLE DEDUCTIONS: 

Line 2.a) Enter the amount of rent collected for bookings that were for 30 consecutive days or 

more. 

 

Manzanita Ordinance 16-03 Section 2 (k) defines Transient or Occupant as “Any individual who exercises 

Occupancy or is entitled to Occupancy in Transient Lodging for a period of less than thirty consecutive 

days, counting portions of calendar days as full days. The day the Transient checks out of the Transient 

Lodging shall not be included in determining the thirty-day period if the Transient is not charged Rent for 

that day by the Transient Lodging Tax Collector. Any such Person so occupying space in a Transient 

Lodging shall be deemed to be a Transient until the period of twenty-nine days has expired unless there is 

an agreement in writing between the Transient Lodging Tax Collector and the Occupant providing for a 

longer period of Occupancy, or the tenancy actually extends more than twenty-nine consecutive days. In 

determining whether a Person is a Transient, uninterrupted periods of Occupancy by the same individual 

extending both prior and subsequent to the effective date of this Ordinance may be considered. A Person 

who pays for lodging on a monthly basis, irrespective of the number of days in such month, shall not be 

deemed a Transient.  

 

 Line 2.b) If you book through VRBO, enter the total amount of Rent that they collected and 

remitted taxes for.  (Do not enter the amount of Tax that they collected and paid.)   

 



 

 

Line 2.c) If you book through Expedia, enter the total amount of Rent that they collected and 

remitted taxes for.  (Do not enter the amount of Tax that they collected and paid.)   

  

Line 2.d) If you book through Airbnb, enter the total amount of Rent that they collected and 

remitted taxes for.  (Do not enter the amount of Tax that they collected and paid.)   

 

Line 2.e) If you book through Evolve, enter the total amount of Rent that they collected and 

remitted taxes for.  (Do not enter the amount of Tax that they collected and paid.)   

 

 Line 2.f) TOTAL allowable deductions: The form will calculate the total of 2a, 2b, 2c, 

2d and 2e on this Line. 

 

Important Note: Make sure to verify that any agents or Transient Lodging Intermediaries that you use 

to book your property have collected and remitted the correct amount of Taxes on your bookings.  You are 

responsible for ensuring that all taxes owed to the City are collected and paid, even if the error was made 

by one of them.     

 

Manzanita Ordinance 16-03 Section 4 H states:  Operators of Transient Lodging and Transient Lodging 

Intermediaries are jointly and severally liable for the aggregate Tax collected each quarter, except in cases 

of nonpayment of Rent by the Occupant. 

 

LINE 3. TAXABLE RENTS: The form will subtract the amount entered on Line 2.f from the 

amount entered on Line 1 and enter that amount on this Line.   

 

LINE 4. TAX CALCULATION: The form will calculate the gross 9% tax on this Line.  

 

LINE 5. SUBTRACT COLLECTION FEE RETAINED: The form will subtract the 5% 

collection fee that you will retain from the gross tax listed on Line 4. 

 

LINE 6. TOTAL TAX DUE: The form will subtract your collection fee on Line 5 from the gross 

tax listed on Line 4 to determine the net tax due on the taxable rent listed on Line 3.  This is the amount of 

tax that will be remitted by you along with this form.   

 

If you use an Intermediary and entered the amount of rent that the Intermediary collected taxes for on a line 

above, you will not include that amount of tax here.  The Intermediary will send that tax along with a 

quarterly tax form for all of the taxes they collected for Manzanita.  (For example, if you only rent through 

VRBO and Airbnb and they will be remitting all of your taxes to the City for you, this line should self-

calculate to state that zero tax is due along with this form.) 

 

LINE 7. PENALTIES: 

 Line 7.a) Delinquent one month after close of quarter: If you are submitting this form, whether 

or not any taxes are owed, after the last day of the month following this quarter, you must pay a penalty of 

either 10% of the net tax due (10% of Line 6) or $100 – whichever is the greater amount.  This penalty will 

not be less than $100.  Enter that amount on this line. 

 

 Line 7.b) Delinquent two months after close of quarter: If you are submitting this form 

after the last day of second month following this quarter, in addition to the penalty listed on Line 7.a, you 

must pay a second penalty of either 15% of the net tax due (15% of Line 6) or $150 – whichever is the 

greater amount.  This additional penalty will not be less than $150.  Enter that amount on this line. 



 

 

 

LINE 8. INTEREST: In addition to the penalties listed above, interest is required to be assessed on 

all delinquent quarterly taxes submitted.  Enter 1% of net taxes due (Line 6) for each month or portion of 

month beginning the first day of delinquency (the first day of the month following this quarter). 

 

LINE 9. TOTAL PENALTIES & INTEREST: The form will calculate the total of Lines 7.a, 

7.b and 8 and enter it on Line 9. 

 

LINE 10. TOTAL TAX, PENALTIES & INTEREST: The form will add Line 6 and Line 9 and enter 

it on this line.   

 

To avoid penalties and interest, payments must be received by this office before the last day of each 

quarter as laid out in Manzanita Ordinance 16-03.   

 

LINE 11. ADJUSTMENT: If you were notified by City staff that you had an overage or a 

shortage of taxes paid on a previous quarterly submittal, you will enter that amount here.  The form will 

either add or subtract the amount entered.  For example, if you overpaid $20.00, you will enter that amount 

on this line as -20.00 and it will subtract the over payment. 

 

LINE 12. TOTAL TAX, PENALTIES & INTEREST DUE TO THE CITY (WITH THIS FORM):  

This is the amount that is due to the City of Manzanita with this form.   

 

SUBMITTAL AND PAYMENT: Email this completed form as a pdf attachment to 

STRprogram@ci.manzanita.or.us.  Please do not send it in any other format or copy it into the body of the 

email.  It must be sent as a pdf attachment.  See instructions on how to create a pdf below if you are unsure 

of how to do this.  Tax payments should be made via this link on the City website:  

https://secure.xpressbillpay.com/portal/payment_forms/?id=MzE1NTQ%3D.  Please be aware that if you 

pay with an e-check the payment company does not charge you a processing fee.  If you pay with a credit 

card, they will charge you a processing fee. 

 

 

 

INPORTANT INFORMATION 

 

CHRONIC LATE SUBMITTALS:  Per Ordinance 10-03 Section 4 “Failure to submit timely 

reports and make timely payment of Short-Term Rental taxes due may result in revocation of the Owner’s 

Short-Term Rental License. This provision applies to all Persons responsible for transient lodging tax 

reporting and payment for a given Short-Term Rental.” 

 

DETERMINATIONS & RE-DETERMINATIONS: As stated in Ordinance16-03 Section 17, the 

City is entitled to collect reasonable auditing costs by City staff and/or auditor fees to determine or re-

determine Taxes owed to the City.   

 

AUDITS: As outlined in Ordinance 16-03 Section 14, you are reminded to retain all information for a 

period of three and one half (3½) years as the City has the right to conduct audits.  The owner is 

responsible for any back taxes and penalties which would be due and payable upon notification from this 

office.   

 

mailto:STRprogram@ci.manzanita.or.us
https://secure.xpressbillpay.com/portal/payment_forms/?id=MzE1NTQ%3D


 

 

PENALTIES MERGED WITH TAX: Per Ordinance 16-03 Section 8, “Every penalty imposed and 

such interest as accrued under the provisions of this Ordinance shall be merged with and become a part of 

the Tax required to be paid.” 

 

FRAUD-REFUSAL TO COLLECT-EVASION:  If the Tax Administrator determines that the 

nonpayment of any remittance due is due to fraud or intent to evade, a penalty of twenty-five percent (25%) 

of the amount of the tax will be added in addition to the penalties and interest assessed.  

 

VIOLATIONS & PENALTIES 16-03:  Per Ordinance 16-03 Section 18 “Violation of any 

provision of this Ordinance shall be considered a Class A Civil Infraction enforceable under the procedures 

described in Manzanita Ordinance No. 15-01 and subject to penalties described therein. The remedies 

provided by this section are not exclusive and shall not prevent the City of Manzanita and/or the Tax 

Administrator from exercising any other remedy available under the law and this Ordinance, nor shall the 

provisions of this Ordinance prohibit or restrict the City of Manzanita or other appropriate prosecutor from 

pursuing criminal charges under State law or City Ordinance. Each day that a violation remains uncured is 

a separate infraction.  

 

Consistent with Section 4(H), Operators of Transient Lodging and Transient Lodging Intermediaries are 

jointly and severally liable for collection and remittance of the City of Manzanita’s Transient Lodging Tax 

and for compliance with all sections and provisions of this Ordinance.” 

 

VIOLATIONS 10-03: Per Ordinance 10-03 Section 6 “Failure to comply with Transient Lodging 

Tax Ordinance 16-03 shall (1) result in an immediate violation and (2) provide grounds for immediate 

revocation of the Owner’s Short-Term Rental License.”  

 

Please see Manzanita Ordinances 16-03 and 10-03 on the City website for more information:  

https://ci.manzanita.or.us/wp-content/uploads/2021/04/Ordinace-16-03-Transient-Lodging-Taxes.pdf 

https://ci.manzanita.or.us/wp-content/uploads/2021/10/Ordinance-10-03-STR-regulations-revised-

09.08.2021.pdf 
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How to convert a picture to a pdf

On Windows
Open Start 

. Click the Windows logo in the bottom-left corner of the screen. The Start menu will 
pop up.

 Alternatively, if you have a picture that you want to convert on your desktop 
or in another similarly accessible location, right-click the picture, 
select Open with, and click Photos to open the picture in the Photos app.

Type photos . This will search your computer for the Photos app, which is where all of your 

computer's pictures are stored.

Click Photos. It should be at the top of the Start menu.

Select a picture to convert. Click a picture that you want to turn into a PDF to open the 
picture.

 If you want to create a PDF with more than one image in it, first 
click Select in the upper-right side of the Photos window, then click each 
photo that you want to add to the PDF.

 If you don't see the image you're looking for, click the More tab and 
select Folders. You can then click Add a folder and select the folder to 
which you've saved your photo so it will be indexed by the Photos app.

Click the printer icon. You will see this in the upper-right corner of the window. Alternative, you 
can press Ctrl + P to open the print dialog screen.

Select Microsoft Print to PDF as the printer. To do this, just click the drop-down menu at 
the upper-left corner of the window, and then choose this option. If it was already 
selected, there's no need to make any changes here.

https://www.wikihow.com/Convert-Images-to-PDF#/Image:Windowsstart.png


Click the Print button. It's at the bottom-left corner of the window. Don't worry, this won't 

actually print your document—it will virtually "print" it as a PDF file instead.

Enter a file name. Type a name for your PDF into the "File name" text box near the bottom of 
the window.

Select a save location. Click a folder on the left side of the window to select it as your PDF's 
save location.

Click Save. It's one of the two buttons in the bottom-right corner of the window. This saves your 

photo as a new PDF file.

 



How to convert a picture to a pdf

On Mac

Open the image you want to convert in Preview. To do this, just double-click the image 
on your computer—it will open in Preview by default.

 If the image opens in an app other than Preview, right-click (or 
press Control as you click) the image, choose Open with, and then 
select Preview.

 If you want to add more images to the current file that you plan to turn 
into a PDF, click the View menu at the top and select Thumbnails. Then, 
drag any additional photos you want to add to the sidebar.[1]

 If you want to rearrange the order of the images in the file, drag their 
thumbnails to the desired positions in the sidebar.

Click the File menu. It's at the upper-left corner of the screen.

Click Export on the menu. This opens options for exporting the document. If you are using 

newest version of macOS, you can also click on Export as PDF and then skip to Step 5 for 
saving the pdf version of image.

Select PDF from the "Format" menu. When you choose this option, you can also choose to 
encrypt the file by adding a password, or to add a Quartz filter (such as a sepia tone) to the final 
document.

Name the document and click Save. This save the image(s) as a PDF file.

https://www.wikihow.com/Convert-Images-to-PDF


How to convert a picture to a pdf

iPhone or iPad

Open the Photos app.  It's the multicolored flower icon on your home screen or in your App 
Library.

Tap the photo you want to convert. You can tap the Albums tab at the bottom first to 
browse by album or select Library at the bottom-left to scroll through your camera roll.

 If you want to select multiple photos to add to your PDF, tap Select at the 
top-right corner of the screen, then tap each photo that you want to select.

Tap the "Share" icon 

. It's the blue square with an arrow at the bottom-left corner of the screen. This opens the 
sharing menu.

Tap Print on the sharing menu. If you don't see this option, swipe up on the sharing menu to 

display the options below the icons.

Zoom in on the image preview to open it in PDF view. On the "Printer Options" page 
that expands, you'll see a preview of your image (or, if you selected multiple images, a 
preview of the first image). To view it as a PDF, place two fingers on the image preview 
and spread them away from one another—a reverse pinch motion. This opens the 
selected picture(s) in a PDF preview.

 If your iPhone has 3D Touch, you can press down on the preview to open it 
in a new window and then press down harder to open the PDF preview.

Tap the "Share" icon 

. This time, you'll see this blue square with an up-arrow at the top-right corner. in the top-
right corner of the screen. This will open a menu at the bottom of the screen.

Tap Save to Files. This option icon is in the bottom row of the menu. If you don't see it, swipe up 

on the sharing menu first.

https://www.wikihow.com/Convert-Images-to-PDF#/Image:Iphoneblueshare2.png
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Select a save location. First, you'll notice that the top of the screen says "Photo.pdf" will 
be saved to (location)." That means your iPhone now knows to create a PDF from the 
selected photo(s). Choose the location on your iPhone or iPad where you'd like to save 
the PDF.

 If you have iCloud Drive enabled, you can select it as your saving location 
instead of your iPhone or iPad.

 No matter where you save the image, you can create a new folder by 
tapping the folder icon with a plus sign in the upper-right corner if you'd 
like.

Tap Save. It's at the top-right corner of the screen. This saves the PDF to the selected location.



How to convert a picture to a pdf

On Android

Download the Image to PDF Converter app from the Play Store 

.
 Type image to pdf converter into the search bar and press Enter.
 Scroll down and select the app called Image to PDF Converter that has a black icon 

with a green sheet of paper, the word "PDF," and an arrow. The developer is DLM 
Infosoft.

 Tap INSTALL.

Open Image to PDF Converter. Tap OPEN in the Google Play Store once the app finishes 
downloading or tap the "Image2PDF" icon in your Android's app list—it's the same black-
and-green icon you saw before.

Tap the plus button ＋. It's at the bottom-right corner.

Tap Gallery. This tells the app to open your image gallery.
 If it's your first time using the app, you'll be asked to give it permission to access 

files on your Android first.

Tap the image(s) you want to convert. You can select one or more images to add to your 
PDF. You should see a checkmark appear at the center of each selected picture.

Tap Done. It's at the top-right corner. This prepares a PDF document containing the 
selected image(s).

Tap the PDF icon. It's a white sheet of paper with a red design (the Adobe logo), and you'll 
see in the upper-right corner of the screen.

https://www.wikihow.com/Convert-Images-to-PDF#/Image:Androidgoogleplay.png


Enter the PDF details. Type a name for the PDF into the top field. Then, you can make 
some optional adjustments, such as locking the file with a password or compressing it to a 
smaller size.

Tap OK to save the file. It's at the bottom-right corner of the window. This saves the PDF 
to a folder called DLMImageToPdf in your Android's default storage location. You'll be 
taken to this location immediately once the file is created.


